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Abstract

This pipeline involves taking pre- and post-operative images to localized and visualize electrode locations in the
case of implanted intracranial electrodes, whether the electrodes penetrate the brain parenchyma (depth,
stereoelectroencephalography, sEEG electrodes) or are on the surface of the cortex (strip or grid,
electrocorticography, ECoG, electrodes). The pipeline uses a number of different packages in a modular approach
that allows use of a subset or all parts of the pipeline depending on need.
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Materials

In order to use our pipeline, download MATLAB, FreeSurfer, and iELVis from these links. A Unix operating system
(Linux OS or Mac 0OS) or a Windows computer with a Linux virtual box must be used (particularly with FreeSurfer
and MMVT).

Required software to produce the images of electrode locations overlaid on MRIs:
MATLAB

FreeSurfer

IELVis

Fieldtrip

For ELA and for parcellating the brain with less command line coding:
MMVT-lite

Shared MATLAB code that uses these packages are located in the below:
Pipeline Code: Place this in your MATLAB folder

For de-identification:
Fieldtrip

For standardizing the data in iEEG BIDS format:
BIDS starter kit WIKI
BIDS starter kit GitHub

Optional software which would allow you to follow the same pipeline include the below:
Mango: Can be used in place of FreeView

LeadDBS: Reconstructed brains and localizes electrodes for DBS Thalamic Lead implants
LeGUI: Also allows co-registration of pre- and post-operative images

DCM2NIIX: Can be used in place of mri_convert

MMVT: Full version not necessary for this pipeline

Our tutorials for familiarizing yourself with the Terminal, setting up your environment, installing Freesurfer, and

installing MMVT, and much more are found here: E APPENDIX.docx
For examples of our basic pipeline output, please see the two attached examples:

E sub-0t3i_lmages_small.pdf E sub-501r_Images_small.pdf

Troubleshooting
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Before start

This pipeline requires a Linux or Mac operating system (OS) to run FreeSurfer and MMVT. Our instructions here
will be specific to Linux, but the same principles apply to a Mac OS. In general, the programs we use (MATLAB
and FreeSurfer especially) have comprehensive installation and tutorials, but we will include bare-bones guides to
get you started. Please look at Appendix | if you are unfamiliar with using the terminal. See the Appendix II-VII on
instructions for checking that your system is correctly configured and installing FreeSurfer. Examples of the
pipeline's output are in the Materials section.

Step 1 requires DICOM retrieval tool

Steps 2-4 require FreeSurfer

Step 5-6 require iELVis, MATLAB, Fieldtrip, and our pipeline code on Github
Step 7 requires MMV T-lite
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Retrieving Images and Saving Files

1
Retrieve Images

Note
May require the installation of a DICOM viewer like Mango (see Materials)

When retrieving imaging as DICOMs, you can download the entire imaging series or just
the sequence of interest, whichever is easiest for your setup. If there is not a T1 MRI with
high enough resolution, a T2/FLAIR image with good resolution can supplement (but not
replace!) the bad T1in the FreeSurfer reconstruction process (see Step 2.2).

1.1 Download pre-op MRI imaging. MRI requirement:
= T1(MPRAGE, SPGR, Ax T1NAV, ect.) with as many slices as possible, good resolution
between grey and white matter, and ideally without contrast (Step 1.2, Panel A).

1.2  Download post-op imaging.
» |deally post-operative CT (Panel C), although post-operative MRI (Panel B) works as
well.

1.3 Convert imaging to NifTl (.nii.gz).
= Use FreeSurfer's mri_convert function to create NifTl files for both MRl and CT
sequences of interest.
= Mango also allows "Files > Save As" for a DICOM folder into a NifTlI
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= |f you run into any issues, dcmZniix may be a good backup program for converting
sequences (see Materials).

FreeSurfer Output

2

2.1

2.2

FreeSurfer Output

Once your imaging scans are selected, move the pre-op NifTl file into the folder required
by FreeSurfer installation (usually somewhere like ~/home/freesurfer/subjects). During
this step, you will open a terminal (right click and select “Open Terminal”) and run the
commands which make all the 3D files, cortical parcellations, and subcortical
segmentations of the input brain. From here on, any instance of “id##" is the name and
number of the subject you are currently running through the pipeline. You must
replace every "id##" with your subject name.

Note

Skip this step if you require only the 2D visuals output. Skipping this step is not possible
for grid and strips because a 3D model of the brain will be required to adjust the electrode
locations in Snap_to_Grid.m.

Move the pre-op NifTl file into the ../freesurfer/subjects/id## folder

freesurfer subjects Subj55 -

+ Downloads

dd Music mri.nii
(1 Pictures miri.nii.gz
"B Videos

Open a terminal window and change directories within it to where you placed the
mri.nii.gz file. Type these four commands, pressing enter after each command:

tcsh

setenv SUBJECTS_DIR ${PWD}

setenv SUBJECT id##_SurferOutput

recon-all -all -s $SUBJECT -i mri.nii.gz -localGI
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cashlab@skydot: fusrflocal /freesurferfsubjects/subj55

freesurfer-linux-ubuntul 86_64-7.2.0-20210721-aa8f76b -------
ng up environment for Frees S-FAST (and FSL)
URFER_HOME fusrflocal/fr rfer
T_HOME fusr/local/freesurferffsfast
_OUTPUT_FORMAT nii.gz

S_DIR fusr}]ucaljfreesurFerfsuhjerts
fusr/local/freesurfer/mni
Jusr/local/fsl

If you want to run the recon-all with a T2, the command looks like this, where "T2.nii.gz"
is the T2 or FLAIR file you wish to use to supplement your T1. You run the first three
commands above the same, and replace the fourth with this:

Command

new command name

recon-all -all -s $SUBJECT -i mri.nii.gz -T2 T2.nii.gz -T2pial -
localGI

2.3  Once finished, copy the pre-op NIfTI file into the id##_SurferOutput/mrifolder and
extract the file so the mri.nii(extracted) is in the mrifolder. The extraction step can
involve unzipping the file using any extraction software (e.g., WinZip, Bitser), or by right-
clicking and selecting some form of “extract”.
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subjects Subj55 Subj55 SurferQutput

3 Pictures
il Videos
&= Trash & Open With Archive Manager
) Tras
Open With Other Application
mri_nu_cof oot . .6 kB
B mad : ¢
Co
lab mri_nu_col ed
E maneya Move to...
& Tarzan - | norm.mgz Copy to...
Move to Trash
& Tarzanz = | nu.mgz Rename... 2 5.0MB
& tiny a , Extract Here )
B °r'g-mgz Extract to... B
[ mmvt_root Compress...
orig_nu.mg cerd bo 5.2 MB
freesurfer -
- rawavg.ma Properties e
B= prman ] g.mg. Ji.omMmg

2.4  If you wish to have a better sub-thalamic segmentation, you can use a segmentation
script supplied in versions of FreeSurfer 7.2 and newer. Run the first three commands
from the recon-all (Step 2.2) and then run:

Command

new command hame

segmentThalamicNuclei.sh $SUBJECT

MRI/CT Co-Registration with Freeview

3 MRI/CT Co-Registration with Freeview
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Note

This manual co-registration step can be done before or after the Surfer Output (Step 2) is
made.

After installing FreeSurfer (Appendix V), this step uses a visualization tool, Freeview, to
view MRIs, CTs, and many other images in 3D space. You will transform the post-op
volume in this 3D viewing tool so that it aligns with the pre-op volume, and thus you can
find the locations of the post-op electrodes in the 3D space of the pre-op images. When
working with Freeview, you will only be manipulating the volume which is highlighted at the
top left of the screen (Step 3.3, Figure). This is the most hands-on and time-intensive step
and will require patience and persistence until you become skilled at it.

There are automatic co-registration approaches (iELVis:
https://www.sciencedirect.com/science/article/abs/pii/S0165027017300365?
via%3Dihub, LeadDBS: https://www.lead-dbs.org/, or

Freesurfer tkregister: https://www.ncbi.nlm.nih.gov/pmc/articles/PMC2733527/ for
instance) which could also be used.

3.1 Open a terminal, type the following command, and press enter. A window will pop up:

Command
hew command hame

freeview

3.2  Load the pre-op file:

= Click on File > Load Volume. A dialog box will appear. Select the pre-op NIfTI volume
file in the browser. Select the "Resample to standard RAS space” checkbox to reorient
to RAS coordinates. Hit "OK".
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Load Volume e

Select volume file
V| Resample to standard RAS space
Load as vector

Apply registration file

Sample method

3.3  Load the post-op file:

= Click on File > Load Volume. A dialog box will appear. Select the post-op NIfTI volume
file. Choose a color map to best visualize the electrodes and skull. We suggest the

heat color map. Hit "OK".
» Further suggested adjustments:

i. Using side selection pane, adjust the min, mid, max, and offset values to best see

Documents/Recons/Subj55/Subj55_SurferOutput/mri/mri.nii.gz = | |

® Nearest neighbor Trilinear Cubic
ALWAYS choose 'Mearest Neighbor' if you are loading a label
volume,

Color map Grayscale

"iigancel | $oK |

the outline of the skull (with the post-op volume selected!).

ii. If using a post-op CT, select the “truncate” and “smooth” check boxes in this

panel to remove noise in the image.
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~ Volumes

| mri.nii

Lot
Filename Documents/Recons/Subjs5/ct.nii
Mask None
Opacity —— 100 |3

v Smooth display
Color map | Heat
Min = 2127

—

Max —_— 1511.05
Offset —_— 0
Use percentile
¥| Truncate Invert

V| Autoset Mid

Clear higher values

3.4  With the post-op imaging highlighted in the top left “Volumes” window (do NOT select
the MRI to transform!), align the skull outline in the post-op imaging with the black of the
MRI using the transform tool:

= At the top, select Tools > Transform Volume to open the tool
There are four options: Rotate, Translate, Scale, and Flip. We suggest that you practice

rotating and translating the selected volume with the sliders to get a sense of what each
one does and feels like to move. Scaling and Flipping are rarely ever needed.
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TransForm Volume ‘

Rotate | Translate | Scale  Flip

® Manual Use Landmarks

Rotations
XIL-R} « |0 degrees
¥ (P-A) « k|0 degraes
ZIi-5) 4 b D deqrees
Axis Point

# Rotate around the center of the volume

Rotate around the cursor

Sample Method

|
| Nearest Neighbor Trilinear (e Cubic

Interpolation method on labe! velumes will always be nearest neighbor.
Therefore, there is risk to lose voxels after rotation.

Apply to all visible volumes

3.5  Transform the volume until the post-op image aligns with the pre-op image.
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Note

We recommend that you write down the rotation and translation numbers that you get
once aligned, in case you ever need to go back to this step in the future. We also suggest
that you should only use the “scale” option in the transform tool as a matter of last resort,
since it is incredibly uncommon for this to be necessary for successful alignment.

Identifying RAS Coordinates

4 Identifying RAS Coordinates
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Note

For this step, you will use Freeview to find the RAS coordinates of each electrode contact.

Write down each R, A, and S coordinate in an excel spreadsheet.

4.1 Make an excel spreadsheet named id##_RAS.xIsx with 4 columns and n+1rows, where n
is the number of electrode contacts for which you find locations in Freeview. The first
column has the names of each electrode contact, and the other three are for the three

axes: R, A, and S. (Right, Anterior, and Superior)

9 4
10 |
1|
12 |
13|

o= RIS N R o B GO R S R 6 R

A

RTGHO1
RTGHO2
RTGHO3
RTGHO4
RTGHOS
RTGHO6
RTGHO7
RTGHOS

RTGHO9
RTGH10
ROFCO1
ROFCO2

34.55
37.93
41.21
44.5
47.86
al.37
54.65
58.46
61.18
63.17
4.8

3

-16.41
-15.87
-15.62
-14.68
-14
-13.81
=12.79
-13.28
12319
11.25
39.44
39.81

-42.33
-43.42
-44 32

-45.1
-45.93

-46.9
-47.45
-48.33
-49.11
-49.49
-41.89
-40.52

4.2 Highlight the pre-op mri volume layer in the top left in Freeview
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DEFFLY 0

* Volumes
W ot

I v T

4.3 Use the crosshairs/cursor to locate each electrode. Click on the center of the contact in
all three views to ensure that you have the most accurate location

4.4  Write down the RAS from the TkReg RAS (mri) row at bottom of screen for each
electrode contact
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BEE? ceilmagys

TR )

Cursor

RAS 45.20, -10.03, -31.55
TkReg RAS (mri) 45.20, -31.55, -10.03

ct 2888 [145. 281. 45]
mri 472 [62, 138, 64]

4.5 Once all RAS coordinates for all electrodes have been located, check to ensure that the
orientation of the coordinates is correct using this test: look at the RAS coordinates
section in Freeview (Step 4.4 Figure, zoomed portion). The R, A, S numbers should
increase positively in the right, anterior, and superior directions, respectively. If they do
not, you must account for this in coordinate transcription. There are 3 options for each of
the coordinates, R, A, and S:

1. All values are in the correct orientation. Nothing additional needs to be done once you
write down the value from Freeview.

2. Some of the values are switched (e.g., R may be in the S position). Test this by moving
the cursor in each of the three directions and making sure the value in the correct
spot changes in RAS instead of ARS or SAR. For example, moving the cursor towards
the anterior of the image will result in the second value in the RAS field changing.

3. Some of the values could be inverted. This means the RAS values are in the correct
order, but they may be flipped. For example, if the R value decreases when you move
the cursor to the right and increases when you move the cursor to the left, then R
values are inverted.

Just account for these changes in the final RAS excel sheet before moving forward.
Multiply inverted columns by -1 or shift columns which were switched in the original

Freeview.

Snapping the Grid to Brain Surface (only applicable for grid/strip (ECoG) electrodes
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5 Snapping the Grid to Brain Surface (only applicable for grid/strip (ECoG) electrodes. If
your subject has exclusively depths (sEEG), skip to next section)

Note

Snapping the electrode grid to the surface of the brain is necessary to account for brain
movement or compression that occurs immediately after grid implantation. This brain
shift can depend on the location and size of the grids used and can influence the location
of the brain in the postoperative MRI or CT. Therefore, the surface of the cortex is different
between the pre-operative scan used in the FreeSurfer pipeline and the post-operative
scan. This difference must be accounted for by shifting the grid to the surface of the pre-
op imaging, rather than relying solely on the post-op imaging.

This section requires downloading iELVis and the GitHub code (see Materials).

5.1 You should create a directory in which you place each subject’s folder. We will call this
the working directory (wd).

5.2  Create an id## folder in the wd containing:
m RAS coordinates in an Excel spreadsheet
= SurferOutput folder for the patient

For each patient, make a new copy of “idxx_Snap_to_Grid.m" from the
Protocol_Snap_to_Grid.m code file located on the GitHub page. This isn't necessary, just
a recommendation.

5.3  Change the Pt (line 10) and the reconPath (line 11) variables to be the patient's name and
the path to your wd folder, respectively.

1 %% Modular Reconstruction and Co-registration of [h.ac;inn from Implanted ECoG and SEEG Electrodes
2 %

3 % Code for Snapping Grids and Strips: to Pial surface

4 2

] T 25 2.

B

7 % For tio i

] %

9

16 - Pt = 'sub.Gt3’;

11 - reconPath = ' /MyPC/Documents/Recons’ ;

12 - [num, txt,alll=xlsread{(fullfile{reconPath, Pt, [Pt ' AAS.xlsx'1 ) };

5.4  Next, you must create a variable which has each electrode’s RAS coordinates. Please
look in the Protocol_Snap_to_Grid.m for an example of how this is done. You can partition
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them up as whole electrodes or break them down into strips. For example, if you have an
8x8 grid, we usually break it down into eight 1x8 strips. Each strip will usually be handled
by the algorithm better than the whole grid, though you can experiment with keeping

them whole.
13 %% Separate each of the grids and strips inte different wariables
14 5 SR reel1:B88 o )bt areral Temporal Grid

15 -

BAS coorgs{l:8. =):

15 - = RAS coords(8:16,:);
17 = grid3 = AAS coords[17:24,:);
18 - grid4 = FAAS coords(25:32,:);

Breaking up an 8x8 Grid into 1x8 Strips

R A 5
Grid01 713 26,58  26.86
Grid02 10.16  26.69  27.18
Grido3 13.22 2705 27.9
Grido4 16.94  27.69  28.51
Grid05 19.06  28.34  29.45
Grid06 23.27 29 29.79
Grid07 26.86  29.42 30.6
Grid08 30.1 30 3159

[Gridbs  33.60  30.07  32.33
Grid10 36.4 3115 32.81
Grid11 40 3151  33.34
Grid12 4317 3259 3435
Grid13 4191  -22.1 2.15
Grid14 43.6 -20 2.6
Grid15 4574  -17.88 3.01
Grid16 483  -14.84 4.1

How the Grid Breakup looks relative to the RAS Coordinates

5.5  Ensure the side variable (line ~40) at the top of the next section is set to the correct
hemisphere ("I" for left, and “r" for right). If you have grids and strips on both
hemispheres, you will have to run this through twice, once for each side.

5.6  Run each of the snap2dural_energy_customized(...) lines (lines 45+) for each electrode
or grid/strip segment.
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h.p1al-outer-smoothed*] ) );

38 % Code for adjusting the Locations of the grids and strips
39 - surface_path = fullfilel reconPath , Pt, [Pt ' _Surferoutput'],
40 - sida = 2

41 % surftype = "pral-outer-smoothed';

42 - [surf.vert surf.tril=read surfl fullfile( surface path, [side
43

44 % We recommend running sach of the following lines one at a time
45 = [arl_coor_snapped] = snap2dural_snergy_customzed(IHA,surf);
46 - [gr2 coor_snapped] = snap2dural_energy_customized(IHP,surf];
47 - [gr3_coor_snapped] = snap2dural_energy_custom zed(GS,surf);

48 - [gra_coor_snapped] = snap2dural_energy customzed(GI1,surf);
49 - [ars_coor_snapped] = snap2dural_energy_customzed(GIz,surf);

Lines of code which snap the RAS coordinates to the surface

gr#_coor_snapped are the newly snapped coordinates.

5.7  When you run this algorithm for each electrode RAS

variable you made, you will see a 3D

projection of the electrodes as they snap themselves to the brain's surface. You should
watch each of these carefully as they will tell you if the algorithm is functioning as
desired. The electrode contact points should be moving along a relatively straight line to

the brain's surface (FIGii). They shouldn't criss-cros

s or come out of their expected

alignment (FIG i). If they do, decrease Maxiter (around line 45) in the
snap2dural_energy_customized.m file. This can involve a lot of trial and error. You can
also check the Tips for Customizing iELVis Code Package.docx file for some help (see

Materials).
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Panel i is a bad snap and requires changing Maxiter. Panel ii is a good snap.

5.8  Once you have the snapped coordinates, run the next two MATLAB sections which
overwrites the input RAS file to have the newly snapped coordinates. This section also
makes a backup so you can redo the snap if need be (id##_RAS_bkp.xiIsx). Make sure
the RAS_coords_new variable (~line 55) has the electrodes in the same order that they
were in the original RAS file. For example, if the input RAS has order of electrodes: GR1-
64, RAH1-16, RPH1-12, STS1-16, then you should have the output
{rasElecName}_coor_snapped in the same order in the RAS_coords_new variable. Plot
the newly made snapped RAS and examine it carefully to ensure it is accurate. This can
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be done by running the first two sections of the imaging code (Step 6) with the newly
shapped RAS.

Panel iis an un-snapped grid, whereas Panel ii is snapped

I Creating Images of MRI with Electrode Overlay

6 Creating Images of MRI with Electrode Overlay
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6.1

6.2

Note

You will have to download MATLAB, Fieldtrip, and our pipeline code from GitHub in order

to proceed with this step. You must initialize 3 variables before you can start. This section

an output 2D and 3D views of the brain with MRI slices in order to show where the
electrodes in the post-op image are in the pre-op image. You should create a directory in
which you place each subject’s folder. We will call this the working directory (wd).

Output examples from this section are attached in the Materials section.

Create an id## folder in the wd containing:
m RAS coordinates in an Excel spreadsheet

= SurferOutput folder for the patient. The mri.nii file should be in the surferoutput/mri

folder.
= |f you are only making 2D visuals (i.e., no SurferOutput), then you must place the
mri.nii in this subject folder as well

This section will work if you have converted your files into the BIDS format (Step 8).

Recons H Q o | . = = o x

T Recent 8
Subjss

+ Starred @ sub-501r
@8 sub-ot3i

(st Home

[ Desktop

2 Documents

£ Downloads

J1 Music

(7] Pictures

Bl videos

™

% Trash

£ HomeDir =

Open “Protocol_recon_code"” (located in Coregistration_Figures_PreOp_PostOp) and

change wd (line 18) to the path to your wd and PatientName (line 20) to your id##. If you
have not run the FreeSurfer section (Step 2), then set surferOutput (line 24) to 0, and you

will only get 2D visuals.
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Add the paths to the Fieldtrip toolbox and GitHub pipeline code on lines 13 and 14.

1 %% Modular Reconstruction and Co-registration of Imaging from Implanted ECoG and SEEG Electrodes
2 % This version was completed an Novenber 15, 2022

3 %

4 % For questrons, pleass post 1ssues to the GrtHub

3 %

6

7- clear all

b= close

9

10 %Add the paths 1n this order only:

11 % Dtherwise, functions in the fieldtrip toolbox which wall make running this code
12 Sdifficult.

13- addpath(genpath({' shame/bourbon- tha-huckster/Documents/MATLAB/ fisldtrip- 20220262'))
14 = addpath(genpath{' /home/bourbon- the-huckster/Documents MATLAB/Fecons/Coregistration Figures Predp_Sostdp'))
15

16 %Path to the recons 2 This should be filled wath subject folders.

17 %Each subject folder will have t rferoutput and RAS Excel

18 - wd = [' /home /bourbon-the- huckster /Documents/Recons/'1;

I8

20 - PatientName="1d##' : % name of the folder and 1d## in the working directary

21

22 % Setting this variable to @ will create anly the 20 vaisuals without

23 % required a Surferoutput from Freesurfer

24 - surferOutput = 1; % Set to 1 if you have run the Freesurfer Reconstruction

6.3  Run the first cell of the code, which sets variables, loads data into MATLAB, and reads
the SurferOutput files you made in Step 2 to create a 3D image of the brain

6.4 Create 3D image with electrodes by clicking "Run Section" in the second cell.
» To change opacity, change number after “facealpha” (lines 136, 138). The range is O-
1, where 1is fully opaque. For depths, 0.3 looks the best, while 0.9-1is best for
grids/strips.
= [f need be, RAS locations can be transformed on line 186-188. This is only necessary
if snap does not work well.
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6.5 Creates Images which re-slices the MRI to capture the plane of the electrode with the
coronal view along the entire depth electrode (skip for grids/strips) by clicking "Run
Section" in the third section. This section involves producing coronal slices which are
angled along the length of the depth electrode to ensure that every contact is shown.

RTGH Channels: 1-10

RTGH

6.6  Create Images Per-Contact with MRIs and 3D Brains from all three views by clicking "Run
Section" in the fourth and final section. This last section creates images for each
electrode location superimposed on the MRI. This step may take many minutes
depending on the number of electrodes.
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RTGH Channel: 1 RTGH Channel: 1 RTGH Channel: 1
~f

RTGH Channel: 1

6.7  On Linux, you can open a terminal in the “Images” folder and run this command if you
install ImageMagick:

Command

new command hame

convert $(1s -v *.png) Recon.pdf

You can also use any PDF creation tool

Multi-Modality Visualization Tool (MMVT) and Electrode Localization Algorithm
(ELA)

7 Multi-Modality Visualization Tool (MMVT) and Electrode Labelling Algorithm (ELA)
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Note

The Multi-Modality Visualization Tool (MMVT) is an open-source python package that
converts the reconstruction output into a Blender (blender.org) file for three-dimensional
visualization of electrode locations which can incorporate MRI, FreeSurfer output, RAS
mapping, and even evoked potentials into the visualization. We will use the “lite” version of
MMVT, which is a stripped-down version, without Blender. Please follow the guide in
Appendix VIl to set up MMV T-lite.

You will need a FreeSurfer Output for the patient (Step 7.3), and a RAS coordinate sheet
(Step 7.4). We recommend keeping them together in a “reconstruction” folder, but it is not
absolutely necessary.

7.1

If you are trying to run this part of the protocol with grids and strips, you need to
separate every column or row of the grid to make it look like a separate depth (GR_##,
GRa_##, GRb_##, etc). This is similar to the grid breakup from Step 5.4.

protocols.io | https://dx.doi.org/10.17504/protocols.io.5qpvornedv4o/v November 30, 2022 26/36



https://www.protocols.io/
https://www.protocols.io/
https://dx.doi.org/10.17504/protocols.io.5qpvornedv4o/v1

@ protocols.io Part of SPRINGER NATURE

GR1
GR2
GR3
GR4
GRS
GR6
GR7
GRB
GRa9
GRall
GRall
GRal2
GRal3
GRald
GRal5
GRal6
GRb17
GRb18
GRb19
GRb20
GRb21
GRb22
GRb23
GRb24
GRc25
GRc26
GRc27
GRc28
GRc29
GRc30
GRc31
GRc32

7.2  Navigate to your “mmvt_root” folder in a terminal. Activate the environment for MMVT

Varl R

-7.755508349
-15.34323393

| -25.84517529

-33.37804495

- -41.01314074
-44. 83876651

-44,13868186
-1
-10

| -17.91282037

-30

| -35.47088567

-43.9921108
-47.84662146

| -49.54358004

-1.399475785

' -12.28743455

-23.46146787

| -31.54000439

-40.68707176

 -47.56842396

-50.96466461
-53.06901592

-3.33725446
-14.63089855
-25.41306303

| .35.47863874
| -44.24557788

=51

| -55.49388181

-35

and change directories:

Command

A

71
73.9753132
7415453237
73.95171674

72.94414814
71.5956788

68.95937598
61
63.34358609
66.8690308
BB

B7
65.46558369
63.18885669

61.32826058

53.88758783

56.54842497

57.03858673

57.57833643

56.28996301

55.47815997

53.0512569

52.43507442

44.99259761

47.07199391

48.22785655
47.79494198
47.75256685
46.42148723

44
41.61996725

new command name

source mmvt/bin/activate
cd mmvt_code

5
0.01 68.81044274

65.6228701
69
65.9407503
59.3284332
52.6561164
43.9785945
352036288
26.1368778
71
71.7011422
68.3000888
63.0812767
55.4499603
475490024
38.203485
28.1745619
75.0386803
74.2067677
70.8944002
64.1658983
58.3048742
50.4045167
40.2293816
30.3211107
78.347231
78.039921
75.1498534
66.9719149
50.623600
52

42
31.8963978
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From now on, make sure you are running every line of code from the “mmvt_code”
folder.

7.3  First, we must parcellate the brain surfaces based on a given atlas. Run this command to
start the parcellation:

Command

nhew command hame

python -m src.preproc.anatomy --remote_subject_dir
"Path/To/id##_SurferOutput" -s id##

It should take a few minutes. You'll get a parcellation of the subject’s brain along with
other surface files in "/.../mmvt_root/mmvt_blend/{id##}" that will let you run the next
step.

Note

You can run this and the next step on multiple subjects at once, see Appendix VII for
information.

The DKTatlas40 is the default atlas. To use another atlas, use the —a flag and the name of
the atlas. For example, adding “-a laus125” will run the parcellation using the lausanne125
atlas. Please see Appendix VII for information about using different atlases.

7.4 Run this command to run the Electrode Localization Algorithm (ELA):
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Command

new command nhame

python -m src.preproc.electrodes --remote_ras_fol "Path/To/id##_RAS
Foldexr” --find_hemis_manual 1 -s id## -b 0

-b 0 finds electrode locations for referential electrodes, -b 1 makes electrode locations

for bipolar electrodes. Run as needed.

= Add --overwrite_ela 1to overwrite files already there

= |f it says: "bad subject”, it's usually fine. This just means not 100% of the algorithm
ran. It will show different error messages if something important for ELA went wrong.

» --find_hemis_manual 1turns on the ability to find the hemispheres for each electrode
manually, though this will usually only require more input if you have grids and strips.
You will have to type “I" or "r" for each electrode when prompted to indicate which
hemisphere of the brain the electrode is in.

The important outputs of the electrode localization step are .csv files that contain the
names of the electrode contact points in the first column and the subsequent columns—
save for the last two—contain the probabilities that the a parcellated area of grey matter
contains electrode contact points. The files are in
/mmvt_root/mmvt_blend/[id##]/electrodes, and they are labeled:

id##_aparc.DKTatlas40_electrodes_cigar_3_I_4.csv

Or:

id##_aparc.DKTatlas40_electrodes_cigar_3_|_4_bipolar.csv
Again, the "-a" flag will be important for specifying the atlas. Please keep the -a flag
consistent between the parcellation and the ELA steps. See Appendix VIl for more
information.
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Note

Verifying the ELA output:

Look at probabilities for electrodes and make sure it makes sense for where they
should be

If it fails, run with ela_overwrite 1 or you must delete files in these three locations to
start over:

/home/cashlab/mmvt_root/electrodes//{id##}
/home/cashlab/mmvt_root/mmvt_blend/{id##} + files at the bottom
/home/cashlab/mmvt_root/electrodes_rois/electrodes

iEEG BIDS Data Formatting for Data Sharing

8 iEEG BIDS formatting of channel labels and file formats

A final step for the RAS file is to prepare the RAS channel data following FAIR practices

(https://www.nature.com/articles/sdata201618) and the standard iEEG BIDS format

(https://www.nature.com/articles/s41597-019-0105-7). For the iEEG BIDS formatting,

manual entry to the RAS file for the electrode types (SEEG, grid, strip, or ECoG),

electrode manufacturer, per-contact surface area (exposure to the brain), electrode
group (e.qg., the prefix label in front of electrode number), and the brain hemisphere.
These details are recommended standard practice for information per RAS file, and, in

our case, we made a copy and named this file:
“(patient designation)_Electrodelnfo_RAS.xlIsx" (
https://www.nature.com/articles/s41597-019-0105-7).

IHAR
IHAZ
IHAZ
IHAL
IHAS
IHALR
DAl
Ol
0A3
b
oOFl
P2
oF3
oPd
HF1
P2
IHP3
IHP4
Gal

H A ] ElectrodeTyp Manafactunes Sufacefneas groun hemlspher

.64 i2.24 1LE1 skrip AdTECH T IHA L
-3 14 13,57 FLOF sirip AdTEeh 7 THA |
R 15,92 3187 wrip adTEch 7 HA L
1.4 17,22 40,76 wrip AATEeN T IHA |
.79 176 4381 rip AdTECH 7 IHA L
R8BS 176 A40.3% atrip BATECH T IHA |
1827 5.7 6. 3F sEEG AdTEch G OA L
B5.27 275 092 5TEG AATECH 6 0A L
1827 0.57 3512 +EEG AdTEeh a0A L
18.3% 217 3582 sEEG AATECH h0A |
11.7F -§7.87 3231 EEG AdTEch &0pP |
13,67 16.17 36,28 sEEG #dTEch aor L
16,24 -14.34 41,08 4EEG AATECH 6 0P |
1855 1227 44,88 = FEG AdTEch & 0or L
203 -F105 33,27 arip AATECH T/IHP L
0,68 -26. X3 41.1F strip AdTEch 7IHP L
-] -r3.66 4758 strip BATECh TIHP |
15.77 1.5 47,18 sarip AdTEch 7 IHP L
i3E 2037 37,88 grid AdTECh ¥ Gs L

Example spreadsheet of the RAS output.
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The spreadsheet file along with other files can then be saved into the iEEG BIDS format,
which involves following the BIDS file structure. Additional code is included
(https://github.com/Center-For-Neurotechnology/Reconstruction-coreg-
pipeline/tree/main/Deidentification_BIDSIiEEG ) that uses the bids-starter kit code
(https://bids-standard.github.io/bids-starter-kit/) and tailors it for this current format.

8.1  The spreadsheet file along with other files can then be saved into the iEEG BIDS format,
which involves following the BIDS file structure. Additional code is included
(https://github.com/Center-For-Neurotechnology/Reconstruction-coreg-
pipeline/tree/main/Deidentification_BIDSIEEG ) that uses the bids-starter kit code
(https://bids-standard.github.io/bids-starter-kit/) and tailors it for this current format.

For the shared example data sets, we then saved all the files into the iEEG BIDS format,
placing the FreeSurfer output, the volumes per brain label (see below), and the MMVT
output (see below) within the ‘derivatives’ folder. See the example data to follow the
same data structure.

eEach participant is listed as sub-XXXX

*There are:

eper-participant files (highlighted in green)

eper-task files (highlighted in blue)

*There is the preimplant scan and postimplant scan (anat) with required .jsonfiles and
both need to be defaced to deidentify the scans

*The file structure and naming matters and needs to be validated using BIDS-Validator:
https://bids-standard.github.io/bids-validator/

eInformation required and recommend in these files are listed here:
ehttps://bids-specification.readthedocs.io/en/stable/04-modality-specific-files/04-
intracranial-electroencephalography.html

*And a tutorial here:
ehttps://bids-standard.github.io/bids-starter-kit/tutorials/ieeg.html
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__5-% DataStructureOrganization - Motepad =

File Edit View

£ah

L— maindirectory/

}— sub-3t7p/

| — ses-preimp/

| | L— anat/

| | }— sub-3t7p ses-preimp_acq-Tlw_run-81_Tlw.json

| | L— sub-3t7p_ses-preimp_acq-Tlw_run-81_Tlw.nii

| L— ses-postimp/

| — anat/

| l — sub-3t7p_ses-postimp_acg-CT_run-01_Tlw.json

| L— sub-3t7p ses-postimp_acq-CT_run-81_Tlw.nii

| L— ieeg/

| — sub-3t7p_ses-postimp_coordsystem.json

| }— sub-3t7p_ses-postimp_electrodes.tsv
| — sub-3t7p ses-postimp task-NetworklWakeSleep2STIMRAW run-81 ieeg.json
| — sub-3t7p_ses-postimp_task-NetworkWakeSleep2STIMRAWNSP1_run-01_ieeg.wmrk
| }— sub-3t7p ses-postimp_task-NetworkWakeSleep2STIMRAWNSPL run-@1_ieeg.vhdr
| }— sub-3t7p_ses-postimp_task-NetworklWakeSleep2STIMRAWNSP1 run-01_ieeg.eeg
| — sub-3t7p ses-postimp_task-NetworkWakeSleep2STIMRAWNSP1 run-81_events.tsv
| }— sub-3t7p_ses-postimp_task-NetworklWakeSleep2STIMRAWNSPL run-@1_events.json
| }— sub-3t7p ses-postimp task-NetworklWakeSleep2STIMRAWNSP1 run-81 channels.tsv
| - ..
| = ..
| L— ..(repeated for each run)
— sub-8m@o/
| — ses-preimp
| L— ses-postimp
1

iEEG BIDS example data organization

Measurements of electrode location relative to brain features

9 Measurements of electrode location relative to brain features

Following electrode localization, there are a number of different measures which could
be relevant to further study, including localization relative to grey and white matter,
different brain regions using a volumetric approach, contact size, and contact spacing.
The organization of the FreeSurfer folders and RAS coordinates allow us to perform
automatic calculations of these metrics using the current code.

A second type of labelling, electrode volume labelling (EVL), involves mapping electrode
locations relative to volumes (as opposed to surfaces like ELA). To do this, we have to
export the FreeSurfer parcellations to volumes, which involves using 3DSlicer
(https://www.slicer.org/). The steps involve importing files from the surfer folder and
then saving the volumes per brain label:
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9.1 Load the brain.mgz and aparc.DKTatlas+aseg.mgzfiles (or whatever atlas you prefer)
from the SurferOutput folder.

Volume erscnmes  Data
export 2t v o
of the native

brain labels B o

1. load the b s
bralnmgz and Subjecthierarchy | Transform hierarchy  Allnodes
aparc.DKTatlas+aseg.mgz
files (or whatever [
atlas you prefer)

B Left-Cerebral-Cortex
B Leftiateral-ventride

XEEEE : UB

orig

transforms

] aparc.a2009s+aseg.mgz @ dventice
D 4th-ventrice

B Brain-Stem

_| aparc+aseg.mgz B Left-Hippocampus
@ Left-Amygdala

o0

] aparc.DKTatlas+aseg.mgz

aseg.auto.mgz
aseg.auto_noCCseg.label_intensities

] aseg.auto_noCCseg.mgz

7 aseg.mgz

| aseg.presurf.hypos.mgz

aseg.presurf.mgz

brain finalsurfs.mgz

3999393999999 999

8, B Right-Cerebelum-White-Matter
| brain.mgz @ Right-Cerebelum-Cortex

mri folder T
in the
Surferoutput » MRML node information

~ Data Probe

V! Show transforms || Show MRML ID's

Show Zoomed Slice

L
E
]

Screenshot of 3DSlicer (https://www.slicer.org/) imported aparc.DKTatlas+aseg.mgz
files overlaid on the brain.mgz file from the FreeSurfer and MMVT-lite ouput (thought it
can just be from FreeSurfer following parcellations
(https://surfer.nmr.mgh.harvard.edu/)

9.2  View the 3D render of the parcellations.

3D render of
DKT parcellations

Screenshot of 3DSlicer (https://www.slicer.org/) visualizing brain region volumes as
3D structures.
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9.3

9.4

Save the output volumes of the parcellations: save (export) to the selected folder.

~ Export to files

£ 3D Slicer 4.11.20210226
Fie Edt View Help

o Bt e

Destination folder: I ¥:ReconPip D fsub-0t3i I..,

o Visble segments only:
. Reference volume: jone -

v | ® segmentations -
File format:

@ | @ Segmentations - | Merge into single: ﬁ’e=| Y:/ReconPipelinePaper /Data/derivatives/ParcellatedVolumes/sub-0t3i |
3DSlicer

Size scale:

Coordinate system: RAS

» Help & Acnowledgement Use compression:

Use color table values: Select a ColorTable hd
Akl seumrbatinr: (e Show destination foider: V

Export

Screenshot of 3DSlicer (https://www.slicer.org/) export of volumes to .stl files

The resultant saved volumes can be used for later processing and mapping of electrode
labels.

The next step involves involves running already created MATLAB code that uses the
FreeSurfer, RAS, and MMVT file output structure to perform different calculations
regarding electrode location, label electrodes based on the DKT40 atlas
(https://mindboggle.info/data.html) or other selected brain atlas maps and produce
output that matches the iEEG BIDS formatting. The code itself
(Measurements_and_Labelling_RAS.m) performs the calculations and is dependent on
the FreeSurfer and MMVT file structures and folder organization but, once organized,
can just be run after pointing the script toward the correct participant designation. The
code produces a spreadsheet (below), which includes further different measures and
brain localization information. The code currently works with MATLAB 2020b onward
though several of the functions can be run with older versions of MATLAB.
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iEEG BIDS columns

output spreadsheet

& » & o & S
» » » » & S & & of S &
& & & &S & N s &
O & & o & "4 > o & » » & &
& & S EA O G LSS
& 2l & o & & N ¢ & & & & s"\\“pe‘v
e et g il 1] amaros|  acooon] Taue | osmmaraasenraus oot | sonsa| et [0
i Every fri = 7 ometnion ool e | osssifasmsies oy e e
ot = Ampsie e | Gmstraes] oo Thok | arianasjoraemsos ey matranc mocartct] | 3| Tk |16
s 2t e et T comaer] ool e | semsm P g
ae et amegses fri S | asoaesse] oomsssor] e | st 2|sammee| s |
acry <t Amvels b il ] o] ascoied e | 2 e rssuee [ae |5z st | =
e ; oot P Iy e | o ooy e |ue
S Sl oy 5] namsosste| —avooon] Tnue | ssaae]ssosseres et B b Bl
Brain Within Inter-contact
hemisphere brain distance
Electrode Distance to Near
group the grey-white
Per-contact grey-white boundary
surface area ELA probability boundary
f electrode in Volume based
Electrode Or1 electroae Dist toth P R
t t istance to the classification:
manufacturer nearest grey matter il surf :
pial surtace subcortical,
Electrode type Brain region label grey matter,
(sEEEG, grid, etc.) (Surface based ELA) white matter, etc.
RAS Brain region ELA probability Number of

coordinates

label (Volume based)

0.77 -2.56 SEEG  PMT S LAMY

L

LAMY13 -51.54 0.77 -2.56 SEEG PMT 5 LAMY L
JLAMY14 -55.3 0.77 -2.96 SEEG PMT 5 LAMY L
jLH1 -16.77 -9.1 0.86 SEEG PMT 5LH L
2 e a0 047 SEEG 1) Dbl L

of electrode in
nearest white matter

other contacts
within 20 mm

1.78036744 6.083548487 white matter
2.1476426 4.84594976  white matter
1.7782879 3.401703123 white matter
1.67070533 2.881621278 grey-white matter overlap

4 3.185733824
4 4.075549043
4 2.981576764
5 3.424426959

ktx-Ih-middletemporal
Ltx-Ih-middletemporal
ctx-lh-middletemporal

| eft-Cerebral-White-Matter
| eft-Cerebral-White-Matter

15 inferiortemporal
15 inferiortemporal
56 middletemporal
56 middletemporal
56 middletemporal

12 0.012698413 0.979366079
12 0.019933555 0.970100668|
11 0.023529412  0.97255002
11 0.06870229 0.93129871
11 0.151515152 0.848485848

measured aistance.
from outer
Gortical boundary

recording
electrodes

didtance:
from greylwhite

matter boundary

Output spreadsheet regarding measures of each contact relative to anatomical features

@ dIPFC
@ dmPFC
@ IOFC
@®

@dACC
@)

@ temporal lobe
@ hippocampus
@ amygdala

as well as features of each contact

De-ldentifying MRIs and CTs

-10 O 14
grey/white probability

log ratio

) I\
9 lii ¥

white matter

a mapped
L electrode
E assignment
A @ cortex
\\ . outer cortex
; @ pial surface
'/ () white matter

&~ @ subcortical

rg regions

10  To remove identifying features, in addition to de-identifying the DICOM headers or re-
saving the data as NIFTI files and removing the identifying header information, with
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instructions and approaches to do so outlined by various other sites
(https://www.fieldtriptoolbox.org/).

An additional step is to remove facial features in the MRI and CT images and save the
images into a format that can be read by steps in the pipeline such as FreeSurfer. This
step involves using the Fieldtrip software and the functions ft_read_mri, ft_defacevolume,
and the ft_write_mri functions. The procedure involves setting the path to the
downloaded Fieldtrip code (see instructions on the Fieldtrip website) followed by running
the functions pointing to the files and directories where the preoperative and
postoperative images were located. The ft_defacevolumefunction opens up a graphic
user interface (GUI) window that allows you to change he rotation and shape of the
yellow box by entering numbers into the lower right corner of the box. Once you are
satisfied the box covers the facial features for the scan, close the window which will
result in saved anonymized MRI which can be saved using the ft_write_mri function.

Manual 1. download and install & seass e preaperative v
defacing . f|e| |p t-00|bOX 1::1 = fcireadin'.zl([Pxe\:\pMRIDL:ecc\:vxy,zFligagrrprl}%égzocl_aeégsxﬁ]);
https//www.fieldtriptoolbox.org/ ez - 1 pre- and post-operative

Z:l_anon = ft_defacevolume (cfg, mri) ‘MRIs and/or CTs

... £t_write mri([PrecpMRIDirectory,'\’,Desig,' anon.nii'l,|...
orm', mri_anon.transform,...

Welcome to the FieldTrip
website

3% Reads the posto scan (CT or MRI)
post = ft_read_mri ([PostopMRIDirectory,'\',PostopMRIFile(1).name]);

on = ft_defacevolume (cfg, post);

ft_write_mri ([PostopMRIDirect

'\',Desig, '_anonPostOPScan.nii'],...

post_anon.anatomy, '

post_anon.transform, ' fti'):

defaced MRI

3. Manually select closing the figure
area to deface window result in
ft_defacevolume the new
saved defaced
volume

}r ange the rotation
and size of the box

to cover the face

4. Check scans
have been defaced
in resultant___~
Pl N FTI files

Manual defacing pipeline using Fieldtrip (https://www.fieldtriptoolbox.org/)
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